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Abstract

The rapid development of transparent zebrafish embryos (Danio rerio) in combination with fluorescent labelings of cells and tissues allows
visualizing developmental processes as they happen in the living animal. Cells of interest can be labeled by using a tissue specific promoter
to drive the expression of a fluorescent protein (FP) for the generation of transgenic lines. Using fluorescent photoconvertible proteins for this
purpose additionally allows to precisely follow defined structures within the expression domain. Illuminating the protein in the region of interest,
changes its emission spectrum and highlights a particular cell or cell cluster leaving other transgenic cells in their original color. A major limitation
is the lack of known promoters for a large number of tissues in the zebrafish. Conversely, gene- and enhancer trap screens have generated
enormous transgenic resources discretely labeling literally all embryonic structures mostly with GFP or to a lesser extend red or yellow FPs. An
approach to follow defined structures in such transgenic backgrounds would be to additionally introduce a ubiquitous photoconvertible protein,
which could be converted in the cell(s) of interest. However, the photoconvertible proteins available involve a green and/or less frequently a red
emission state1 and can therefore often not be used to track cells in the FP-background of existing transgenic lines. To circumvent this problem,
we have established the PSmOrange system for the zebrafish2,3. Simple microinjection of synthetic mRNA encoding a nuclear form of this
protein labels all cell nuclei with orange/red fluorescence. Upon targeted photoconversion of the protein, it switches its emission spectrum to far
red. The quantum efficiency and stability of the protein makes PSmOrange a superb cell-tracking tool for zebrafish and possibly other teleost
species.

Video Link

The video component of this article can be found at https://www.jove.com/video/53604/

Introduction

Exponentially improving imaging techniques allow following developmental processes over time periods of up to about four consecutive days3.
In zebrafish and many other animal model systems, specific cells, tissues, axonal or vascular structures are marked by transgenic green or
sometimes red or yellow fluorescent proteins to facilitate visualization. However, in most transgenic lines the transgene is not specifically
expressed in the cells of interest but also additional structures, which hinders the precise tracking of for instance single cells or groups of cells.

Fluorescent photoconvertible proteins are well suited for cell tracking during embryonic development. The prerequisites for the application of
such proteins are a long-lived nature, a well-separated emission range upon conversion and bright fluorescence. Available photoconvertible
proteins comprise those that change their emission range upon conversion such as Kaede4, KiGR5, mEos26, PS-CFP2 or Dendra27 and
others which are only fluorescent when photoactivated (PAmCherry8, PAGFP9 or PATagRFP10). Their applications to track cells in existing FP-
transgenic animals are however limited as they often involve a green fluorescent state or do not fulfill all of the above criteria. Only recently,
Subach and colleagues reported the PSmOrange protein, which changes its emission from orange/red to far red upon photoconversion and was
successfully applied in cells in culture and cultured cells injected into mice2.

To investigate the protein's suitability for cell tracking in a living embryo, we generated an expression construct for the microinjection of nuclear-
tagged H2B-PSmOrange into zebrafish embryos. We find that the protein fulfills all prerequisites for successful cell tracking in GFP transgenic
backgrounds during the first 4 (and possibly more) days of zebrafish embryonic development. During this time, most of the cell migratory events
are completed in fish making the PSmOrange system an excellent addition to the zebrafish toolkit.
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Protocol

1. H2B-PSmOrange mRNA In Vitro Transcription and mRNA Purification

1. Linearize the H2B-PSmOrange containing pCS2+ plasmid using the NotI restriction enzyme according to manufacturer's instructions.
 

Note: Perform the next steps using appropriate protections such as gloves and lab coat to prevent mRNA contamination and degradation.
2. Purify the linearized DNA using a PCR Purification kit or phenol-chloroform based methods according to manufacturers' protocols.
3. Use 1 µg of linearized template DNA for Sp6-mRNA transcription according to manufacturer's instructions.
4. Remove DNA by adding 1.0 U RNase free DNaseI for 10-20 min at 37 °C.
5. Clean up the mRNA using a RNA clean up kit according to manufacturer's protocol.
6. To increase mRNA purity and concentration, precipitate the mRNA by adding 6 µl sodium acetate (3.0 M, pH 5.2) and 150 µl 96% ethanol.

Incubate the mixed solution at -20 °C for at least 30 min and up to 24 hr.
7. Collect the mRNA by spinning the solution at 18.407 x g for 45 min at 4 °C. Discard the liquid and resuspend the mRNA in 150 µl 70%

ethanol. Mix and centrifuge the solution for an additional 15 min at 4 °C. Discard the liquid, dry the pellet for 5 min on ice and resuspend the
mRNA in 20 µl ultrapure RNase free water.

8. Assess the concentration and purity of the mRNA by photometric measurement of a 1:100 mRNA dilution (1 µl mRNA in 99 µl ultrapure
RNase free water).

9. For short-term storage, keep the mRNA solution at -20 °C. For long-term storage, keep the mRNA at -80 °C.

2. H2B-PSmOrange mRNA Microinjection into Zebrafish Embryos

1. Set up mating pairs the night before injection using tg(foxD3:GFP); tg(flh:GFP) double transgenic fish (or any other GFP transgenic fish).
Leave the fish separated by placing a spacer between them to control the time of mating.

2. Remove the spacer in the morning of injection and let the fish mate for 20 min.
3. During mating time, dilute the H2B-PSmOrange mRNA to the final concentration of 130 pg/nl (in RNase free water) and transfer 6 µl injection

solution into a microinjection capillary using a microloader tip. Check the injection volume with a calibrated glass slide. Adjust the injection
pressure to inject 2 nl mRNA solution (260 pg).

4. Collect the eggs into a sterilized plastic petri-dish containing 1x Embryo (E3) medium.
5. Transfer 20 to 30 embryos to an injection dish using a plastic pasteur pipette.
6. Inject 2 nl mRNA containing solution into the cell or just below the cell into the yolk at the one-cell stage 11.
7. Transfer injected embryos into a petri-dish containing 1x E3 medium, remove unfertilized or not normally developing embryos and grow them

at 28 °C.
 

Note: Light protection of the embryos is not required throughout the experiment.
8. Raise zebrafish embryos in 1x E3 medium and add 0.2 mM PTU (1-phenyl-2 thiourea) after gastrulation to inhibit pigmentation. Change the

medium twice per day to minimize the danger of bacterial contaminations.

3. Embryo Embedding

1. Select the GFP (green) and PSmOrange (orange/red) co-expressing embryos using a binocular microscope equipped with a fluorescence
lamp and appropriate emission filters. Transfer the positive embryos into a sterile petri-dish containing 1x E3 medium.

2. Dechorionate embryos under a stereomicroscope using forceps 12.
3. Transfer one embryo in a 1.5 ml tube containing 1.0 ml of pre-warmed 1.0% low melting agarose (LMA) prepared in ultrapure water by using

a cut-tip pipette (P200). Note: Warm the LMA to 80 °C and cool down for 3-5 min at RT before embedding the embryo.
4. Transfer the embryo in 150 µl LMA into a chambered coverglass and adjust the embryo's orientation, e.g. dorsal side down in the experiment

described for the inverted confocal laser scanning microscope A1R+ (or any other suitable microscope), using a fine plastic tip. When the
LMA is polymerized, fill the chamber with fish water containing 0.2 mM PTU and 0.02% ethyl 3-aminobenzoate methansulfonate (Tricaine) for
anesthesia.

5. Before imaging the sample, wait 15 min to ascertain the effect of Tricaine. The anesthesia prevents embryo movements, which can be
monitored using a stereomicroscope equipped with brightfield illumination.
 

Note: The chambers can be reused twice.

4. PSmOrange Photoconversion

1. Place the sample under the confocal microscope and scan the specimen to identify the area to photoconvert using 488 nm and 561 nm lasers
for imaging GFP and PSmOrange respectively.
 

Note: Use the inverted confocal laser scanning microscope A1R+ on the inverted stage TiEcontrolled by the microscope imaging software
and equipped with 488 nm, 561 nm and 640 nm lasers for photoconversion and imaging. However, the application is certainly not restricted to
this microscope as long as the laser lines for conversion and imaging are available.

1. Put the 20X air objective into place (NA: 0.75; WD: 1.0 mm; FOV: 0.64 x 0.64 mm).
2. Use the following microscope settings to detect the PSmOrange protein before photoconversion: 561 nm laser, 0.74 mW measured at

the focus plane above the objective.
 

Note: This corresponds to 40% on this system (measuring in the focus plane is the only way to determine the effective power). Adjust
the laser power according to experimental needs as the efficiency of H2B-PSmOrange injections can vary.

3. Add zoom factors to highlight the area of interest. Higher magnifications reduce image acquisition time and therefore phototoxicity.
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2. Acquire a z-stack covering the structures of interest using 488 nm and 561 nm lasers in sequential mode (line mode 1->4). Fix the z-step
between 1.0 and 2.0 µm. Line average and scan frequency can be used to optimize image quality.

3. Scan the sample and select the region of interest (ROI) tool to highlight the area to photoconvert. Fix the ROI as stimulation area. Select the
Photo Activation/Bleaching module, activate the 488 nm laser by checking the respective box and set the 488 nm laser to 80% (1 mW laser
power measured at the objective). Set the scan speed to 0.5 sec/Frame.

4. Open the photoconversion utility (ND Stimulation) and specify the photoconversion settings.
1. Click on the "Add" command to specify the photoconversion protocol.
2. Set "Phase" 1 in the "Acquisition/Stimulation" menu to "Acquisition" and indicate the number of images to be acquired before

photoconversion in the "Loops" menu.
3. Set "Phase" 2 to "Stimulation" and enter the number of stimulation events to be performed.
4. Adjust "Phase" 3 as described for "Phase" 1. Optionally, insert a waiting "Phase" after "Phase" 2 by entering the time to wait before the

last round of image acquisition.
5. Once all the parameters are set, apply the stimulation setting and run the photoconversion.

 

Note: Laser power, frequency of scanning and number of iterations for each round of photoconversion can vary and differ from embryo
to embryo. A setting to start with is shown in Table 1.

5. Acquire a final z-stack using 488 nm, 561 nm and 640 nm lasers applying the settings as above. Set the 640 nm laser to visualize the
converted PSmOrange using high laser power (up to 4.5 mW).

5. Dismount Embryo from LMA

1. Remove the embryo containing chamber from the microscope. Carefully remove the embryo from the agarose using forceps.
2. Transfer the embryo into a new sterilized plastic petri-dish or into a sterilized 6-well-plate containing 1x E3 and 0.2 mM PTU. Incubate the

embryo at 28 °C until the desired stage of development.

6. Analyzing the Fate of Photoconverted PSmOrange Protein Expressing Cells

1. Re-embed the embryo as described under points 3.3 and 3.4.
2. Place the sample under the confocal microscope and scan the specimen to identify photoconverted cells (640 nm) in the GFP transgenic

structure of interest (488 nm).
3. Acquire a z-stack covering the structures of interest using 488 nm, 561 nm and 640 nm lasers in sequential mode (line mode 1->4). Fix the z-

step between 1.0 and 2.0 µm. Line average and scan frequency can be used to optimize image quality.
4. Use one of the following methods to identify cells, which co-express GFP and the photoconverted protein.

1. Custom made automatic Fiji ImageJ Macro3

1. Convolve the original stack using the "GaussianBlur" plugin ( → Process → Filters → GaussianBlur) and subtract the smooth
stacks from the original using the "Image Calculator" plugin (→ Process → Image Calculator). Use this step to visualize the
structures of interest and reduce the computational time for the analysis.

2. Apply specific thresholds to the green and far-red channels in order to highlight the photoconverted cells ( → Image → Adjust
→ Threshold). Use the "Analyze Particles" tool to detect the threshold areas with a suitable setting ( → Analyze → Analyze
Particles).

3. Open the "Image Calculator" plugin and display the overlapping ROIs in the green and far-red channel in yellow ( → Process →
Image Calculator).

2. Microscope imaging software for 3D data evaluation
1. Display the stack in 3D using the show volume view option ( → 3D Visualization Menu → Show Volume View). Use the graphic

interface to select the green, red and far-red channels, adjust the brightness and the contrast and crop the 3D stack to highlight
the photoconverted area (Figure 1).
 

Note: Similar methods to analyse the data are available in most of the common software for image analysis.
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Representative Results

Figure 1 illustrates an example of the PSmOrange photoconversion system. The pineal complex is a conserved structure in the vertebrate
dorsal diencephalon. Like in many other vertebrates, this complex consists of the pineal organ in the center of the diencephalon and the left-
sided parapineal cells. Elegant but time-consuming uncaging experiments showed that parapineal cells originate in the anterior part of the pineal
organ13. In tg(foxD3:GFP); tg(flh:GFP) transgenic embryos, both pineal and parapineal cells are labeled during development. To assess the
suitability of the PSmOrange system we used these embryos to reproduce the reported pineal complex development. 260 pg mRNA encoding
the nuclear form of PSmOrange, H2B-PSmOrange, was injected into one-cell stage double transgenic embryos to express the protein in all cell
nuclei. Injected embryos were incubated at 28 °C until 24 hr post fertilization (hpf), selected for GFP and strong H2B-PSmOrange expression
and embedded in LMA in a chambered coverslip system with the dorsal side oriented towards the bottom. The specimen was placed under
an inverted confocal laser scanning microscope controlled by microscope imaging software and equipped with 488 nm, 561 nm and 640 nm
lasers and a 20X air objective for photoconversion and tracking. Two cell clusters in the anterior part of the pineal were photoconverted and
immediately imaged (Figure 1A-F). The photoconverted cells could be visualized using the 640 nm laser (far red - Figure 1C), but not with the
561 nm laser (orange/red - Figure 1B). GFP expression in these cells was initially also reduced due to photobleaching (Figure 1A, 1D, 1F). At
52 hpf GFP and H2B-PSmOrange was detected in the photoconverted H2B-PSmOrange protein expressing cells (Figure 1A'-F'). Indeed, a few
of these cells formed the parapineal on the left side of the brain (arrowheads in Figure 1A'-F'). This result is consistent with previous reports on
the parapineal cell origin and shows the applicability of the PSmOrange technique in the living vertebrate embryo.
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Figure 1. Identifying the parapineal cell origin using the PSmOrange photoconversion system in living zebrafish embryos. (A-F') Dorsal
views with anterior to the top focused on the dorsal diencephalon of a tg(foxD3:GFP); tg(flh:GFP) transgenic embryo highlighting the pineal (P)
and the parapineal cells (pp) at (A-F) 26 hpf immediately after photoconversion and (A'-F') 26 hr later at 52 hpf. The embryo was injected with
mRNA encoding H2B-PSmOrange. The pictures show 3D reconstructions. Expression of (A, A') transgenic GFP, (B, B') not converted H2B-
PSmOrange (red channel) and (C, C') after photoconversion (far-red channel). White dotted circles highlight the area of photoconversion, which
is devoid of orange/red fluorescence. (D, D') Merge of all three channels (green, red, far-red), (E, E') red and far-red channels and (F, F') green
and far-red channels. (A'-F') White arrowheads highlight the location of parapineal cells, which show green, orange/red and far-red fluorescence.
(A-F') The scale bar is displayed on the right bottom corner of each image. Please click here to view a larger version of this figure.

Phase Number of Loop Active Lasers

Acquistion 1 cycle 488 nm, 561 nm, 640 nm

Stimulation 15 to 30 cycles 488 nm

Maturation 1 min #

Acquistion 1 cycle 488 nm, 561 nm, 640 nm

Table 1: Conditions for H2B-PSmOrange photoconversion.
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Discussion

Transgenic embryos carrying fluorescent reporters have helped fundamentally to understand embryonic development. However, there is still the
essential need for promoters to facilitate the specific visualization of particular structures. In their absence, researchers rely on techniques such
as the photoconversion of fluorescent proteins to find out about the origin and development of their structure of interest. This in turn is a crucial
prerequisite to identify the molecular mechanisms involved in its development. Technical advances in the zebrafish field now allow to replace
the FP in transgenic lines with, for instance, photoconvertible proteins using a CRISPR-Cas9 mediated knock in approach14,15. However, this
technique is relatively time-consuming and not always successful. In contrast, the application of ubiquitously expressed H2B-PSmOrange in GFP
and possibly other transgenic backgrounds is a straight-forward technique to follow cells through embryonic development.

For instance, the origin of the zebrafish ventral habenulae, one part of a conserved neural conduction system in the dorsal diencephalon of
vertebrates, has been elusive until recently and hence no genetic cascade underlying its development was uncovered. Using the PSmOrange
system and long-term time-lapse analysis to follow migrating cells, we could show that unlike the dorsal habenular nuclei, which originate left and
right adjacent to the epiphysis, ventral habenular neurons develop posterior to this region in the thalamus3. This knowledge allowed us then to
identify the crucial function of the canonical Wnt signaling downstream gene Tcf7l2 for ventral habenular neuron development.

The application of the photoconvertible PSmOrange system is simple, fast and has the advantage over photoactivatible proteins that embryos
can be selected for strong protein expression before illumination. Synthetic mRNA encoding for H2B-PSmOrange is injected into the GFP-
transgenic embryo to ubiquitously express the orange fluorescent protein in all nuclei. We have not encountered any side-effects upon injection
and the protein is stable for at least 96 hr. The protein is then photoconverted in GFP-transgenic cells in the ROI using a 488 nm excitation
laser and the embryo can be analyzed for the now far-red fluorescent protein containing cells within the subsequent approximately 48 hr. It is
critical to monitor the successful photoconversion as conditions can vary depending on the developmental stage of the embryo and the tissue
targeted. The microscope imaging software acquires an image of each channel (green, red and far-red) before and after photoconversion. The
photoconversion efficiency can be evaluated measuring the mean intensity fluorescence in the ROI between the different channels before and
after photoconversion. If no far-red fluorescence is detected immediately after photoconversion additional rounds of photoconversion have to be
applied. GFP bleaching is common after photoconversion. However, the continuous translation of the transgenic fluorescent protein overcomes
this problem within about 2 hr.

A custom made macro for Fiji ImageJ to ease the identification of cells co-expressing the photoconverted protein and the transgenic GFP
is available3. Future establishment of stable transgenic lines expressing the H2B-PSmOrange will further simplify this procedure. It will also
facilitate the analysis of developmental events after 4 days post fertilization, which might have intriguing value to research areas like tissue
regeneration. In addition, the combination of maternally expressing PSmOrange transgenics and time-lapse imaging16 will be a powerful tool for
investigating cell migratory events starting before gastrulation on a single cell level. Further applications may include the exchange of the H2B
nuclear tag with, for instance, GAP43 to visualize cell membranes and potentially axons in the developing embryo.

One limitation of this technique is that the zygotic protein only starts to be expressed after gastrulation and is therefore not applicable to the
analysis of gastrulation processes. It also has to be considered that it is rather difficult to photoconvert the protein in cells located deep in the
embryo. Photoconversion settings must be adapted as the high laser power and relatively long stimulation time needed for photoconversion may
result in tissue damage, which requires careful monitoring.
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